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Navigating this document:

 

Please use one of the methods described below to quickly find the desired informa-
tion in this on-line documentation:

 

• Use the Table of Contents provided by the Acrobat Reader program.

• Use the Adobe Acrobat Reader Search function.

• Click on a cross-reference (green text) to jump to the respective topic.

 

It is of course possible to print out this document or parts of it.

Additional Information on how to use the Adobe Acrobat Reader program can be 
found in its on-line Help.
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Welcome to ReCycle!

 

First of all we’d like to thank you for purchasing ReCycle! You are now in posses-
sion of a unique tool which will be an enormous time saver and which will add 
great creative possibilities to your music making.

Before ReCycle, using drum loops was very technical. Also, once you had commit-
ted yourself to a sample, you were stuck with its inherent tempo, its bass drum pat-
tern, its snare sound etc. A bit like painting by numbers.

With ReCycle all that has changed. This program puts you – the musician – back in 
control, and lets you concentrate on what you do best. Which of course is creating 
music.

 

What can I do with ReCycle?

 

With ReCycle, you can perform a number of pretty amazing “tricks” on your drum 
loops:

 

• Change the tempo without affecting pitch.
• Change the pitch without affecting tempo.
• Quantize drum loops (either to straighten up the timing or to change the feel, 

for example by applying a “groove map”).
• Extract the timing (a groove map) from a drum loop. This can then be applied 

to other sequenced parts or even to other loops!
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the basic feel.
• Extract sounds from loops.
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Copyright Issues

 

The raw material with which you feed ReCycle is drum loops, grooves, breakbeats, 
or whatever sampled weirdness you find appropriate. Included in this package is a 
great selection to get started with. When you grow out of that you’ll find a wealth of 
other sampling CDs and CD-ROMs out on the market to pick from. However, 
please read the following text carefully:

Every published recording carries a warning, like this:

 

• "All rights of the producer and owner of the recorded work are protected by 
law, unauthorized copying, public performance..."

 

The text above means it is illegal to use this recording in your own work, unless you 
obtain permission (see below). 

 

●

 

Failing to observe a copyright warning may result in legal action taken against 
you. Make absolutely sure any material you use in your own recordings is 

 

cleared for use, or you may find yourself in serious legal trouble!

 

Some CDs (and other media) are created specifically for sampling. Even then you 
must ensure the result is properly cleared for use in your own recordings. If you 
find a disclaimer text that goes something like the one below, beware:

 

• "Every effort has been made to ensure that this CD contains sounds you can 
safely use in your music. However, the producers of this product can not ac-
cept responsibility for any direct or consequential loss..."

 

In this case, please contact the producer to find out exactly what applies. Again, do 
not use any material from this medium without making sure it is properly cleared 
for use.

 

Clearing

 

So, how do you go about obtaining permission to use a recording, often referred to 
as “clearing a sample”?

The owner of a CD is listed on the CD, in conjunction with a “P” symbol and a 
date. Contact the owner to obtain permission. If you can’t find the owner, contact 
the company following the © symbol on the CD. If you can’t find that either, con-
tact the manufacturer or record label listed on the packaging. Please note that there 
are several types of clearance, for different types of usage. Preferably contact an at-
torney familiar with copyright law, for assistance.
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About This Manual

 

Operation Manual vs Sampler Supplement

 

• The Operation Manual covers basic operations.
• The Sampler Supplement contains sampler specifics, export file information 

and key commands.

 

Mac vs Windows

 

The doumentation is both for the Macintosh and Windows versions of ReCycle. 
Most pictures show the Macintosh version but things are identically titled and posi-
tioned in both versions.

Sometimes, a key command is different in the two versions. This is indicated like 
this: Hold down [Option] (Mac) / [Alt] (Win) and...

If a paragraph specifically relates only to either version of the program, this is indi-
cated like this:

Macintosh version only.

Windows version only.

Mac:

Win:
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Requirements

 

To use ReCycle for Macintosh you need the following:

 

• Any Power Macintosh with a CD-ROM drive and 16-bit audio.
• 16 MB of RAM or more.
• System 8.0 or later.

 

For communication with your specific sampler, you might also need:

 

• A MIDI Interface and cables, and/or...
• SCSI cables.

 

For SCSI communication, your computer must use SCSI Manager 4.3 (see page 
16).

 

Setting Up The Computer

 

Before proceeding, your computer should be set up and you should be reasonably 
familiar with its operation. You should also install all peripherals, such as MIDI in-
terface etc.

 

Turning on your system

 

1. If you have any peripherals connected to the computer or sampler, al-
ways turn these on first.

2. If you are using a sampler with the operating system on a floppy disk or 
hard disk, make sure the operating system is loaded before you turn on 
your computer.

3. Turn on the computer.

 

It should come alive, showing the desktop after a while. If it doesn’t, check 
your SCSI setup as described at the end of this manual.

 

4. Make sure Virtual Memory is Off, in the Memory Control Panel.

 

This is necessary for trouble-free audio playback. If Virtual Memory is On, 
turn it off and restart the computer.

 

Finding your way on the ReCycle CD-ROM

 

Once you have turned on your system, insert the ReCycle CD-ROM and open it in 
the Finder. At the root of the CD-ROM, you will find a file called “Read Me”. Dou-
ble click this to get information about what is what on the CD-ROM.
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Installing the Acrobat Reader

 

To be able to read the online documentation, you must have the Acrobat Reader ap-
plication installed. If this isn’t already installed on your computer, you need to in-
stall it from the ReCycle CD-ROM:

 

1. On the ReCycle CD-ROM, open the folder “Acrobat Reader” and double 
click on the file “Reader 3.xx Installer” (where “xx” is the version 
number of the Acrobat reader, e.g. “02”).

2. Follow the instructions in the dialogs that appear.

3. At the end of the installation you may be required to restart your compu-
ter again. Do so.

 

Installing ReCycle

 

1. On the CD-ROM, double click the icon named “ReCycle Installer”.

2. Use the options in the dialog to select a hard disk with a System folder on 
it. Follow the instructions on screen.

3. Click the “Install” button.

4. At the end of the installation you may be required to restart your compu-
ter. Do so.

 

●

 

Don’t launch ReCycle yet! You need to perform some additional steps first: 

 

Setting Up The Sampler, MIDI and SCSI

 

●

 

If you don’t plan to use ReCycle with an external sampler, you can skip this 

 

section.

 

1. Open the Sampler Supplement (a document in Acrobat format in the Re-
Cycle folder), look up the Appendix that describes your specific sampler, 
and check the heading “Support and Requirements”.

2. If the sampler connection requires MIDI, turn to Appendix A  in the same 
document and install OMS as described there.

3. Again, please look up the relevant sampler Appendix, and install and set 
up the sampler as described there.

 

●

 

Please read the section about your specific sampler thoroughly! If your sam-
pler communicates with the computer via SCSI, please note that improper 
SCSI connections may cause permanent damage to the computer, sampler 

 

and other SCSI peripherals.
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Read the Read Me file!

 

In the ReCycle! folder that was created on your hard disk during installation you 
will find a file called Read Me. This will contain any late-breaking updates that 
didn’t make it into the manual. Please double click on it and read it before proceed-
ing.

 

Register your software!

 

Please fill out and send in the registration card that comes in this package. Doing so 
will make sure you are entitled to technical support and kept aware of updates and 
other news regarding ReCycle.

 

Launching ReCycle

 

1. Locate your ReCycle program icon (in the new “ReCycle!” folder on the 
hard disk, 

 

not

 

 on the CD-ROM) and double click on it.

2. The program prompts you to insert the ReCycle CD-ROM (if not already 
in the drive).

 

This is only required the first time you run the program.

 

3. A dialog box appears, asking you to enter your name, company and serial 
number. Do so, and click OK.

 

The serial number is printed on the Registration Card which is included in the 
ReCycle package. Again, this procedure is only required the first time you run 
the program..

 

4. Now, you will be asked whether the program should search for con-
nected samplers. If you have any samplers connected, click Yes; if you 
plan to use ReCycle without external samplers, click No.

 

When ReCycle finds a properly connected sampler, it is automatically added 
to the Sampler list. You can modify the Sampler list later if you wish to add, 
remove or rename samplers. This is described on page 42.

 

5. Finally, an Open dialog appears, asking you to locate an audio file for 
opening.

 

This is the same dialog that appears when you select “Open” in the program 
(see page 45). If you don’t want this to automatically open when you launch 
ReCycle, you can turn this feature off in the Preferences dialog.
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Setting up Audio

 

ReCycle plays back audio directly from your computer, using whatever sound ca-
pabilities it has. If your Macintosh has 16 bit 44.1kHz audio quality, then this is 
what you get. If you have a Sound Manager compatible audio card installed, the au-
dio can be routed to this.

 

●

 

Please note that the audio quality during direct playback from the computer 
may not be immaculate. However, this does not reflect the final audio in the 

 

sampler, since this always maintains highest possible quality.

 

If you want to use the internal audio in your computer, we recommend that you 
connect the audio output on the back to your sound system instead of using the 
Macintosh built in speaker.

 

Audio Settings in ReCycle

 

After launching ReCycle, you should open the Preferences dialog on the Edit menu 
and check the Sound Manager Audio settings at the top.

 

The two Audio Playback Modes

 

ReCycle uses the Sound Manager on the Macintosh to play audio. This allows it to 
play in the background and happily co-exist with other audio applications. Great 
care has been taken to make ReCycle compatible with all other Sound Manager ap-
plications. This is what we call “Multitasking friendly” audio playback.

However, there’s a problem with some combinations of Sound Manager versions 
and certain Mac hardware, where ReCycle can’t automatically determine the cor-
rect “audio buffer size”. This might lead to crackles or glitches in the audio play-
back.

 

●

 

We recommend all users to check the buffer size, as described below, even if 
you don’t have problems with your audio. If you can use a lower buffer set-
ting than the default, the program will be more responsive to control move-

 

ments.
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On some rare occasions, adjusting the buffer size might not be enough to remedy 
the Sound Manager problems. In this case, you have the option of selecting another 
method for playing back audio, which we call “Crackle safe”. Selecting this 
method has some drawbacks though, see below.

 

Setting the Correct Buffer Size 

 

Normally you should leave the Sound Manager Audio setting at “Multitasking 
friendly”. However, you should make sure you have the correct audio buffer size 
setting. Proceed as follows:

 

1. Select “Open” from the File menu.

2. In the dialog that appears, select the audio file “Drum Tools Demo.aif” in 
your ReCycle folder, and click Open.

 

The Drum Tools Demo loop opens.

 

3. Activate Playback by clicking the Play button.

4. Open the Preferences dialog from the Edit menu.

5. Make sure the “Multitasking friendly” mode is selected.

6. Locate the Buffer size pop-up.

7. Select the 

 

smallest

 

 buffer size that allows you to play back audio without 
problems.

8. If none of the buffer sizes seem to work, switch from “Multitasking 
friendly” to “Crackle safe”, in the Preferences dialog and set the buffer 
pop-up to the value closest to “(1024)”.

About the Crackle Safe Option

 

Selecting the Crackle Safe option will make sure that ReCycle works properly in all 
situations. However, the mouse pointer will not move as smoothly and you might 
possibly run into audio problems with other programs playing via the Sound Man-
ager. Furthermore ReCycle might possibly disturb other background processes 
such as networking.
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System Information

 

When ReCycle is running, you will find an additional item on the Apple menu, 
called “System Information”. If you select this item, a dialog will open, displaying 
information about your computer and the SCSI and OMS configurations:

 

General

 

This section contains info about your computer’s processor type, operating system, 
physical memory and virtual memory. You cannot change these settings. 

 

SCSI

 

This section indicates whether SCSI Manager 4.3 is installed (required for SCSI 
communication in ReCycle), and contains a pop-up menu where you can view the 
available SCSI buses.

 

• It doesn’t matter which SCSI bus is “selected” on the pop-up menu. The 
pop-up is only there for you to view the available SCSI buses.

OMS

 

This section contains information about the installed OMS version. By using the 
pop-up menu, you can check which MIDI interfaces are available.

 

• Again, it doesn’t matter which interface is “selected” on the pop-up 
menu. The pop-up is only there for you to view the available interfaces.

Copy to Clipboard

 

Clicking this button copies the contents of the System Information dialog onto the 
Macintosh clipboard. You can then paste this into a text file or an e-mail, e.g. when 
contacting tech support.
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Memory setting and Audio files

 

Every Macintosh program has a memory setting. This is used to tell the computer 
how much RAM memory to reserve for a particular program. This setting can be 
changed from the Finder as described below.

When ReCycle ships, you will be able to load 30 seconds worth of 44.1 kHz audio. 
This is a total figure which can be divided by as many windows as you like. You 
might for example have a 6 seconds long sample in one window and a 4 seconds 
long sample in another window.

In addition to this, more free memory is needed when you transmit samples to your 
sampler.

If you find you need to increase the amount of memory dedicated to ReCycle, pro-
ceed as follows:

1. If ReCycle is running, save the files you are working on.

2. Quit ReCycle.

3. Locate the ReCycle icon in the Finder and click on it once to select it.

4. Select Get Info from the File menu. 
Exactly what the dialog that appears looks like depends on what System soft-
ware version you are using. What you are looking for is the setting for the 
maximum amount of memory that should be assigned to ReCycle.

5. Change the memory setting by clicking on it and typing in a new value.
As a guideline, for each 100 kbyte that you increase the setting with, you will 
be able to load approximately one more second of sound.

6. Now, ReCycle will use this amount of memory, if it is available. If there 
isn’t that much memory for it to “grab” (you might have other programs 
running which already occupy some of your memory), it will use as much 
as it can get. If the program can’t even find the “minimum” amount of 
memory, it won’t start.

For more information about the memory settings in the Get Info dialog, see your 
Macintosh manual.
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Getting Help and Additional Info
If you pull down the Contacts menu in ReCycle, you will find four menu items that 
allow you to contact the manufacturers and get support:

● For these items to be useful, you need to have a valid Internet connection and 
an Internet browser installed on your computer.

• Go to the Propellerhead Homepage...
This menu item brings you to the homepage of Propellerhead Software, 
where you will find information about new ReCycle versions, etc.

• Go to the Steinberg Homepage...
This menu item brings you to the homepage of Steinberg, where you will find 
information about ReCycle, Cubase VST and other Steinberg programs, as 
well as lists of Steinberg distributors worldwide.

• Download Drum Loops...
This menu item brings you directly to the Drum Loop page on the Propeller-
head web site. Here you can download various drum loops for free.

• ReCycle! Tech Info and Support...
This menu item brings you directly to the ReCycle Support pages on Stein-
bergs web site. Use this option if you are having trouble with ReCycle and 
need help!
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Requirements
To use ReCycle for Windows you need the following:

• An Intel Pentium computer running at 66 MHz or faster.
• A 640x480, 256 color monitor or better.
• A CD-ROM drive.
• 16 MByte RAM or more.
• A Windows compatible, 16-bit audio card.
• Microsoft Windows 95/98 or NT 4.0 or later.

For communication with your specific sampler, you might also need:

• A Windows compatible MIDI Interface and cables, and/or...
• A 100% Windows compatible SCSI interface and cables.

Setting Up The Computer
Before proceeding, your computer should be set up and you should be reasonably 
familiar with its operation. You should also have the audio card installed and work-
ing properly.

• To check whether your audio card works properly, try playing back audio 
with the Media Player application (included with Windows).

● The quality of the sound during direct playback from ReCycle depends fully 
on the audio card. If you have a not-so-good audio card, this may mean that 
the sound quality during direct playback from the computer isn’t immaculate. 
However, this does not reflect the final audio in the sampler or in exported 
files, since this always maintains highest possible quality.

Depending on whether you plan to use a sampler, and the model of the sampler(s), 
you may also need MIDI and/or SCSI interfaces. See page 22. 

Turning on your system
1. If you have any peripherals connected to the computer or sampler, al-

ways turn these on first.

2. If you are using a sampler with the operating system on a floppy disk or 
hard disk, make sure the operating system is loaded before you turn on 
your computer.

3. Turn on the computer.
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Finding your way on the ReCycle CD-ROM
Once you have turned on your system, insert the ReCycle CD-ROM and open it. At 
the root of the CD-ROM, you will find a file called “Read Me”. Double click this to 
get information about what is what on the CD-ROM.

Installing the Acrobat Reader
To be able to read the online documentation, you must have the Acrobat Reader ap-
plication installed. If this isn’t already installed on your computer, you need to in-
stall it from the ReCycle CD-ROM:

1. Insert the ReCycle CD-ROM.

2. On the  CD-ROM, open the folder “Acrobat Reader” and double click on 
the application file “ar3xx.exe” (where “xx” is the version of the Acrobat 
Reader, e.g. “02”).

3. Follow the instructions in the dialogs that appear.

Installing ReCycle
1. On the CD-ROM, double click the icon named "Install ReCycle 1.7".

2. Follow the instructions in the dialog box that appears.

3. At the end of the installation you may be required to restart your compu-
ter. Do so.

● Don’t launch ReCycle yet! You need to perform some additional steps first: 
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Setting Up The Sampler, MIDI and SCSI

● If you don’t plan to use ReCycle with an external sampler, you can skip this 
section.

1. Open the Sampler Supplement (a document in Acrobat format in the Re-
Cycle folder), look up the Appendix that describes your specific sampler, 
and check the heading “Support and Requirements”.

2. If the sampler connection requires MIDI, you need to have a MIDI inter-
face installed and working.
To install a MIDI interface, follow the instructions in the manual that came 
with it. Make sure to install the latest driver for the interface.

3. If the sampler connection requires SCSI, you need to have a SCSI inter-
face installed and working (see “Installing SCSI” below).

4. Again, please look up the relevant sampler Appendix, and install and set 
up the sampler as described there.

● Please read the section about your specific sampler thoroughly! If your sam-
pler communicates with the computer via SCSI, please note that improper 
SCSI connections may cause permanent damage to the computer, sampler 
and other SCSI peripherals.

Installing SCSI

ReCycle works with any SCSI host adapter that is 100% Windows compatible.

● Do not connect anything to the SCSI card until you have finished installation 
of the card and its drivers. Also read the section in the on-line Sampler Sup-
plement document about your specific sampler thoroughly before making 
any SCSI connections.

About SCSI IDs

The SCSI host adapter itself normally has its SCSI ID set to 7. This means that no 
other device can be set to SCSI ID 7.
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Verifying SCSI Communication with the Sampler

The SCSI communication between the computer and the sampler can be viewed as 
two different links: the communication between the SCSI host adapter and the sam-
pler, and the communication between Windows and the SCSI host adapter. Both 
these links need to be verified.

● If any of the verifications below fail, you need to check your SCSI connec-
tions and settings and try again. Again, make sure you have read the section 
about your sampler in the online Samplers documentation.

Verifying that the SCSI Host Adapter “sees” the Sampler

When you turn on your computer after having connected and booted the sampler, 
look at the initial BIOS information displayed on screen (before Windows is 
started). When the BIOS of your SCSI host adapter starts, you will note that it scans 
the SCSI bus for connected units. If your sampler is properly connected and run-
ning, the SCSI host adapter should find it and display its name briefly.

Verifying that the Sampler is registered by Windows

When Windows starts you should get an alert saying that “Windows has found new 
unknown hardware”. This indicates that Windows has found your sampler. The 
“Add New Hardware Wizard” will then appear, asking you to install device drivers 
for the hardware. Proceed as follows:

1. On the first page of the Wizard, just click “Next”.

2. Next, select the option “Search for the best driver for your device” and 
click “Next”.
The Wizard will now display a page with options for where Windows should 
look for the new driver (floppy disk, CD-ROM, etc).

3. Make sure none of these options are selected, click “Next” and then 
“Next” again.
The Wizard will now inform you that Windows hasn’t installed a driver for 
the device, which is precisely what we want.

4. Click “Finish”.

● Depending on the type of sampler, the “Unknown Hardware” alert may be 
shown again and you may have to perform the steps above several times. This 
is perfectly normal - just go through with it. You will only have to do this the 
first time you start the computer with the sampler connected.
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Read the Read Me file!
In the ReCycle folder that was created on your hard disk during installation, you 
will find a file called Read Me. This will contain any late-breaking updates that 
didn’t make it into the manual. Please double click on it and read it before proceed-
ing.

Register your software!
Please fill out and send in the registration card that comes in this package. Doing so 
will make sure you are entitled to technical support and kept aware of updates and 
other news regarding ReCycle.

Launching ReCycle
1. Locate the ReCycle entry on the Start menu and select it.

2. The program prompts you to insert the ReCycle CD-ROM (if not already 
in the drive).
This is only required the first time you run the program.

3. A dialog box appears, asking you to enter your name, company and serial 
number. Do so, and click OK.
The serial number is printed on the Registration Card which is included in the 
ReCycle package. Again, this procedure is only required the first time you run 
the program.

4. Now, you will be asked whether the program should search for con-
nected samplers. If you have any samplers connected, click Yes; if you 
plan to use ReCycle without external samplers, click No.
When ReCycle finds a properly connected sampler, it is automatically added 
to the Sampler list. You can modify the Sampler list later if you wish to add, 
remove or rename samplers. This is described on page 42.

5. Finally, an Open dialog appears, asking you to locate an audio file for 
opening.
This is the same dialog that appears when you select “Open” in the program 
(see page 45). If you don’t want this to automatically open when you launch 
ReCycle, you can turn this feature off in the Preferences dialog.
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Audio Settings
After launching ReCycle, you should open the Preferences dialog on the Edit menu 
and check the Audio Card Driver settings.

Selecting an Audio Card Driver

The first thing to do is to select a driver for your audio card. There are two main 
types of audio card drivers for Windows:

• MME (MultiMedia Extensions) drivers.
Practically all audio cards come with an MME driver. However, with MME, 
only one program at a time can access the audio card. Using MME may also 
result in a noticeable latency, causing the audio playback to be slightly de-
layed. In the case of ReCycle, you would notice this in that playback started 
slighlty after you clicked the Play button, for example.

• DirectX drivers.
DirectX is a later system developed by Microsoft to provide developers with 
more efficient routines to access audio (you may also encounter the term Di-
rectSound, which simply is the audio playback part of DirectX). It allows sev-
eral programs to access the same audio card, and results in a lower latency 
value. However, not all audio cards come with a DirectX driver.

As a rule, you should try selecting a DirectX driver as a first choice. Proceed as fol-
lows:
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1. To see which drivers are available on your system, pull down the Audio 
Card driver pop-up.

2. If one of the drivers is clearly labelled “DirectX” or “DirectSound”, se-
lect it. Otherwise, select the last driver on the list.

3. When you have selected a driver, check the “Driver Type” text below the 
pop-up menu.
It should say “DirectX”, nothing else. If it says “Emulated DirectX”, try select-
ing other drivers on the pop-up menu and see whether anyone of these is a 
true DirectX driver.

A DirectX driver selected.

4. If none of the drivers is a true (non-emulated) DirectX driver, you should 
select an MME driver instead.
Select the first item on the menu that corresponds to the name of the card you 
want to use. Avoid selecting drivers with generic names. The “Driver Type” 
text below the pop-up menu should now say “MME”.

An MME Driver selected.
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Setting the Audio Card Buffer

It is very important that you trim the buffer setting properly. The buffer setting is a 
balance between fast response to playback commands on one hand and “safe” au-
dio playback on the other.

1. Select “Open” from the File menu.

2. In the dialog that appears, navigate to the ReCycle program folder.
Make sure the “All Files” option is selected on the “Files of type” pop-up 
menu.

3. Open the file “Drum Tools Demo.aif”.

4. Activate Playback by clicking the Play button.

5. Open the Preferences dialog from the Edit menu.

6. In the Preferences dialog, locate the playback performance slider and 
drag it all the way to the right.

The playback performace slider.

7. Now drag the playback performance slider to the left, a bit at a time. Try 
positions further and further to the left, until the sound starts ”breaking 
up” and the “Underruns” indicator starts incrementing.

8. Drag the fader a little bit to the right, so that the sound is OK again.

9. Close the dialog.

You are now finished with your audio settings for ReCycle. The settings you just 
made are stored automatically.
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Getting Help and Additional Info
If you pull down the Help menu in ReCycle, you will find menu items for getting 
help, support and information:

Help Contents

If you select “Contents” a regular Windows Help dialog appears. Use this to 
quickly find information about details and techniques in the program.

• You can also get help by clicking the Help button in dialogs, by pressing 
[F1], or by clicking the question-mark icon in a dialog and then clicking 
on the item you want to know more about.

Contacts

The next four items on the Help menu allow you to contact the ReCycle manufac-
turers and distributors for support and more info.

● For these items to be useful, you need to have a valid Internet connection and 
an Internet browser installed on your computer.

• Go to the Propellerhead Homepage...
This menu item brings you to the homepage of Propellerhead Software, 
where you will find information about new ReCycle versions, etc.

• Go to the Steinberg Homepage...
This menu item brings you to the homepage of Steinberg, where you will find 
information about ReCycle, Cubase VST and other Steinberg programs, as 
well as lists of Steinberg distributors worldwide.

• Download Drum Loops...
This menu item brings you directly to the Drum Loop page on the Propeller-
head web site. Here you can download various drum loops for free.

• ReCycle! Tech Info and Support...
This menu item brings you directly to the ReCycle Support pages on Stein-
bergs web site. Use this option if you are having trouble with ReCycle and 
need help!
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System Information

If you select this item, a dialog will open, displaying information about your com-
puter and the MIDI and SCSI configurations:

• You cannot change any settings in this dialog - it is only there to give you 
information.
The pop-up menus are really just lists of installed drivers.

General

This section contains info about your computer’s processor type, Windows version, 
physical memory and DirectX version.

Sound

This section contains a list of the available Audio Card Drivers. If you select one of 
the drivers from the pop-up menu, the version and type (MME/DirectX) of the 
driver are displayed below.

MIDI

This section contains a list of the available MIDI ports. If you select a port with the 
pop-up menu, its driver version is displayed below.

SCSI

This section indicates which version of ASPI (the protocol for SCSI communica-
tion under Windows) is installed. The pop-up menu contains a list of the available 
SCSI buses.
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Copy to Clipboard

Clicking this button copies the contents of the System Information dialog onto the 
Windows clipboard. You can then paste this into a text file or an e-mail, e.g. when 
contacting tech support.

About ReCycle

Selecting this item brings up a dialog listing the fine people involved in creating 
this program.
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How ReCycle Works
There are many things you can do with ReCycle. But the most common application 
is to slice a loop for tempo changes or editing. These are the basic steps (details fol-
low later in this chapter):

1. Load the loop in from your sampler, or, if you have the loop as an audio 
file on your hard disk, open it.
The program now analyses the loop and detects the individual “hits” or 
“sounds” in it. It then displays it as a waveform in a window.

2. The second step is to work with the Sensitivity slider and the tools to set 
up a number of slices.
Each slice represents an individual sound in the loop. Slices are displayed as 
vertical lines across the waveform.

3. The slices are now used for setting up loop points. You can play back the 
audio directly in ReCycle to check that the loop is correct.
The loop settings are later used by ReCycle to calculate the tempo of the sam-
pled loop, among other things.

Once you have the slices and loop points set up as desired, it’s time to put the loop 
to use. At this point the procedure is different depending on whether you are using 
ReCycle with a sampler or in conjunction with another computer program that can 
read REX (ReCycle Export) files (such as Steinberg Cubase VST):

Transferring and Using the Loop in a Sampler

1. First you need to transmit the sliced-up loop back to the sampler. Only 
this time, each slice is transmitted as an individual sample.
The samples are automatically mapped across the “keyboard” in the sampler, 
chromatically. This means that if you play the new samples in succession, you 
get the original loop back. This would be very hard to do by hand, so...

2. Next, let the program create a MIDI file that will play the slices, one af-
ter the other each with the correct length.

3. Once all this is done, you are finished with ReCycle. Now you load the 
MIDI file into your sequencer program and play it back from there.
This will perfectly recreate the way the loop originally was. But now that the 
loop is broken down into slices, you can change the tempo in the sequencer 
and the loop will follow. You can also perform detailed editing, quantizing 
and other operations on the MIDI file. This will be equivalent to editing the 
loop, since each note in the MIDI file directly represents a sound in the loop!
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Exporting and Using the Loop in another Program

1. Export the Loop as a ReCycle Export (REX) file.
This is a special file format, that contains both the audio data of the loop, the 
slice information and the original tempo.

2. Launch Cubase VST (or another program that reads REX files), and im-
port the REX file onto an Audio Track.
The slices will now appear in their correct order and positions, and you will 
be able to change tempo and manipulate the slices much like when using a 
sampler.

● The handling of REX files is described in detail on page 83.

On the following pages you will find a quick tutorial. After this are handling in-
structions for all different aspects of the program. In the chapter “Example Appli-
cations” you will find more practical examples of what you can do with ReCycle.

Using ReCycle with a Sampler - Step By Step 
The text below assumes that you have installed ReCycle and a MIDI sequencer 
such as Cubase and that all connections to your sampler are set up and working. If 
not, please see the Installation chapter for more information.

1. Launch ReCycle by double clicking on its icon.
A File dialog appears.

2. Locate the file called “Drum Tools Demo.aif” in your ReCycle folder.

3. Select the file and click Open.
You will be asked whether you want the Left Locator to be moved to the first 
Slice point (see page 49 for more info). Click Yes.

The Drum Tools Demo loop.
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4. In the window, click the Play button.
You should now hear the entire loop, from start to end, repeating until you 
click the Stop button.

5. Drag the Sensitivity slider to the right, until its value is between 70 and 
80 and a number of lines appear.
We call those lines and their triangle symbols “slices” since they indicate that 
the sound has now been cut up into slices.

The Sensitivity Slider and some slices.

6. Position the mouse pointer over the “L” handle (the Left Locator) and 
drag it to the right a bit and release it.
As you will see, it winds up exactly on one of the slices, and on the next lap, 
playback starts from this point.

7. Drag the Left and Right Locators until the loop is exactly one bar long.

8. With playback turned off, move the pointer over the waveform view.
The pointer changes to a speaker symbol.

9. Click with the Speaker pointer on the slices in the waveform view.
You will hear each individual sound in the loop. The slice you clicked last is 
indicated by a dotted vertical line to the left - this slice is called the Current 
Slice.

Stop Play

The Locators set up 
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10.Click in the “Bars” field, type “1”, and hit [Return].
The actual tempo of the loop gets calculated.

The Bars/Beats settings and the calculated Tempo.

11.Pull down the Sampler menu and check the Transmit options (the items 
from “Pitch to New Tempo” to “Silence Selected”). They should all be 
turned off (no tick mark). 

12.Pull the “Stretch” slider to 25%.
You can read more about what Stretch does on page 75.

So, now we have everything we need, a perfect loop, a tempo, a good set of slices 
and a stretch setting. Let’s send this stuff to the sampler.

13.Pull down the Sampler menu and select the sampler you want to use, at 
the bottom of the menu. 
The available options on this menu depends on which samplers you have 
added to the Sampler List, manually or automatically, as described on page 
39. Some options are always available.

14.Pull down the Sampler menu and select the top item on the menu 
(“Transmit to...” or “Export as...”, depending on what you selected in the 
previous step).
A dialog box opens. Exactly what the dialog looks like depends on the sam-
pler. As an example, we’re showing the Yamaha A3000 dialog.

15.Click “MIDI File+Transmit” (or “MIDI File+Export” depending on what 
you selected in step 13 above).
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Now the following happens:

• The slices get transmitted to the sampler (if it is an external instrument) 
or a file dialog appears asking you where to put the files needed for the 
sampler (if you have selected a “file-based” sampler format such as Sam-
pleCell or SoundFonts). 
For details, see page 76.

• A regular file dialog box appears allowing you to position and name the 
MIDI File (we will later use this file to play back the loop). Save the file.

● If you don’t use ReCycle together with a sampler, but rather with another 
computer program such as Steinberg Cubase VST, at this point you would ex-
port the sliced-up loop as a REX (ReCycle Export) file. This is described on 
page 83.

Now we are actually done with ReCycle for a while. Let’s start using the stuff that 
the program produced for us.

1. If the sampler is inside your computer you will need to load the instru-
ment by using software that came with the sampler. If the sampler is ex-
ternal, you will only need to make sure that the “Program” (or whatever 
it is called) that was created, is selected and that the instrument is re-
ceiving on the MIDI channel of your choice.

2. Launch your MIDI Sequencer and make sure you are also transmitting 
correctly to the sampler (set the MIDI Output and MIDI Channel).

3. Play your keyboard to check the material in the sampler. You will note 
that each key plays a slice. What was previously one long recording is 
now a number of short snippets spread out over the keyboard. If you play 
the keys chromatically upwards, the loop will be recreated (although 
probably not with perfect timing!).

4. Load the MIDI file you just saved to disk into your sequencer program. 
Set it to output to the sampler and start playback.
The loop will play back as it originally did.

5. Try changing the tempo in the sequencer.
The fact that you can lower the tempo is thanks to the Stretch setting in ReCy-
cle. See page 75 for details.

6. If you want to, you can also try customizing the loop by editing, rear-
ranging and duplicating the events in the sequencer.

7. In the sampler, try re-tuning samples, altering envelopes, sending sam-
ples to different outputs, panning etc.

Congratulations! You just tried out all the basic capabilities of your new program! 
Of course, there’s a lot more to learn and discover. Please proceed to the following 
chapters to find out about all the capabilities of this amazing program!
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The Sampler Settings dialog

● If you are not using ReCycle with a sampler, you can skip this chapter.

The Sampler Settings dialog on the Edit menu is where you set up and edit the 
Sampler List. The samplers you have included on this list will be available on the 
Sampler menu in the main ReCycle window, for transmit and receive operations.

The items on the bottom of the menu are taken from the Sampler List.

● That a sampler is on the list doesn’t mean it’s set up correctly or even con-
nected to the computer! ReCycle doesn’t automatically remove samplers 
from the list if they are not connected. You may temporarily disconnect your 
sampler between sessions, without having to set it up in ReCycle again.
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Finding all Connected Samplers

● This is not possible for Ensoniq samplers! If you have one or several Ensoniq 
samplers connected, you must add these manually as described in the section 
“Adding an Ensoniq Sampler” on page 41.

ReCycle can scan the SCSI and MIDI connections and automatically add all prop-
erly connected samplers to the Sampler List:

1. Open the Sampler Settings dialog.
You should have turned on and booted all connected samplers before you 
turned on the computer and launched ReCycle.

2. Click the “Find All...” button at the bottom of the dialog.
ReCycle scans for samplers.

3. When a properly connected sampler is found (that isn’t already on the 
Sampler List), you will be asked if you want to add it to the list.
Click “Yes” to add the sampler to the list.

4. If a sampler is found, that is already included on the Sampler List, ReCy-
cle will tell you this.
Click “Skip” to continue the search.

● ReCycle will only find one sampler of each model - if you have more than 
one sampler of the same model connected, you need to add these manually 
(see page 40).

• If a sampler is found, that isn’t properly connected, ReCycle will inform 
you of this and tell you what you need to do.
For example, you may have a Yamaha A3000 sampler connected via SCSI 
only. The program will find it, but since this sampler requires a MIDI connec-
tion, it will not be added to the Sampler List. Instead you will be asked to 
check your MIDI connection and MIDI interface.

Once the Find All process is complete, all properly connected samplers have been 
added to the Sampler List (provided that you clicked “Yes” for each one of them in 
step 3 above). You can check this by pulling down the Sampler pop-up menu at the 
top of the dialog.

You can now rename and edit the settings for samplers on the list, as described be-
low.
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Adding a Sampler Manually

You can manually add a sampler to the Sampler List at any time, regardless of 
whether the sampler is connected or not. This is useful if you want to set up your 
system before you connect your samplers, or if you have several samplers of the 
same model connected (since ReCycle only “finds” one sampler of each model):

1. Click the “Add...” button at the bottom of the Sampler Settings dialog.
The Add Sampler dialog appears.

2. Use the Model pop-up menu to select the sampler model you want to 
add.
Note that each actual sampler model may have more than one entry on the 
pop-up menu, if there are different ways to connect the sampler (e.g. via MIDI 
or via SCSI).

● There are special considerations for some E-mu samplers - please read the E-
mu chapter in the Sampler Supplement online document!

3. If you know that the sampler is connected and booted, click the “Find...” 
button.
ReCycle scans the MIDI and/or SCSI connections for a sampler of the selected 
model. If it finds one, you are asked whether you want to add it to the Sam-
pler List. If you click “Yes”, the sampler is added to the list with the correct 
SCSI ID and/or MIDI SysEx ID settings.

● Please note that ReCycle will only find one sampler each model - if you have 
more than one sampler of the same model connected, you need to add these 
by clicking “OK” instead, and adjust the MIDI/SCSI settings manually in the 
Sampler Settings dialog, as described on page 42.

4. To add a sampler without “finding” it, click OK.
A sampler of the specified model is added to the Sampler List, with default 
values for SCSI and/or MIDI settings. You will probably have to change the 
SCSI and/or MIDI settings manually later.
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Adding an Ensoniq Sampler

For technical reasons, Ensoniq samplers cannot be automatically “found” by ReCy-
cle. This means you have to add Ensoniq samplers manually, without “finding” 
them (by clicking OK in the Add Sampler dialog as described above), and then ad-
just the MIDI settings in the Sampler Settings dialog.

● To make sure your settings are correct, use the Verify function in the Sampler 
Settings dialog, as described below.
Note: Make sure the Ensoniq sampler isn’t in “Load Mode”, as this will disa-
ble MIDI communication!

Verifying the Connection with a Sampler

Near the lower left corner of the Sampler Settings dialog, you will find a small icon 
next to a “Verify” button. The icon indicates whether the currently selected sampler 
on the Sampler pop-up menu is properly connected (on-line) or not. 

For example, if you add a sampler manually without using the “Find” function, the 
icon will be a red cross, indicating that the sampler isn’t on-line. If the selected 
sampler is found automatically by ReCycle, the icon will be a green check mark, 
indicating that the sampler is on-line.

• To update the status of the icon and check the connection to the cur-
rently selected sampler, click the “Verify” button.
For example, you may want to do this after having changed SCSI or MIDI set-
tings, as described below.

• Each time you launch ReCycle, the program automatically Verifies the 
connection with all samplers on the Sampler list.
If a sampler isn’t on-line, it will not be available on the Sampler menu.

Sampler on-line. Sampler not on-line.



- 42 - 

Making Settings for a Sampler

In the area to the left in the Sampler Settings dialog, you can adjust the settings of 
the currently selected sampler. There are three sections:

• Name.
This shows the name of the sampler as it will appear on the Sampler menu in 
the main ReCycle window. If you wish to rename it, click the “Rename...” 
button and enter a new name. 

• MIDI settings.
If the selected sampler uses a MIDI connection, you will find settings for MIDI 
In/Out ports and SysEx ID. To change these, use the respective pop-up menu.

• SCSI settings.
If the selected sampler uses a SCSI connection, you will find settings for SCSI 
Bus and SCSI ID. To change these settings, use the respective pop-up menu.

● If you change the MIDI or SCSI settings manually this way, you should always 
use the Verify function to check that the sampler is on-line.

Read the Sampler Information!

When a sampler is selected (on the Sampler pop-up menu), you will see an image 
of its front panel displayed to the right in the Sampler Settings dialog, along with 
model and connection information. Below the image, you will also find the follow-
ing information:

• Required OS.
This is the operating system required for the sampler to work with ReCycle.

• Found OS.
This is the operating system currently used by the sampler. If this is an older 
OS version than the “Required OS”, you need to upgrade the sampler.

• Notes.
Under this heading you may find additional important information. There 
may for example be certain settings you need to make in the sampler before 
using it with ReCycle. Make sure that you follow the instructions under this 
heading carefully!
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Deleting a Sampler from the list

If you wish to remove a sampler from the Sampler List, proceed as follows:

1. Pull down the Sampler pop-up menu and select the sampler you want to 
remove.
A picture of the sampler is displayed, together with information about the re-
quired Operating System and additional notes.

2. Click the “Delete...” button at the bottom of the dialog.

3. Click “Yes” to confirm that you want to remove the sampler.
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About Sounds and Memory
Whenever ReCycle displays audio in a window, it has to load it into the computer’s 
RAM memory. 

If you want to be able to load a lot of sound files or if you want to have many win-
dows open at the same time you will need to assign the program more memory. See 
page 17 for more info.

How much audio you can load into the program at one time depends on how much 
memory you have in your computer (total) and how much of it that other programs 
are currently using. If the program tells you there is not enough memory for a cer-
tain operation, or if you can’t open an audio file (in any of the supported formats), 
the first thing to try is to quit other programs.

You can open files that are up to five minutes in length, if you have enough memory 
for it. To open a five minute file (or two files that are two and a half minute long, for 
example) ReCycle has to have access to 26 MByte of memory. Please not though, 
that Transmitting audio requires even more memory (the exact amount depending 
on the length of the Slices and the Stretch factor).

Using Open

The Open dialog.

The Open item on the File menu is used to load audio files from the hard disk.

The dialog box is a standard file dialog with some additions.

● By default, this dialog will appear automatically when you launch ReCycle. If 
you don’t want this, open the Preferences dialog on the Edit menu, and deac-
tivate the “Show Open Dialog on Startup” option.

Mac:

Win:
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File Info

When you select a file in the list, information about file type, length, etc is shown in 
the lower part of the Open dialog.

The File information

Channel Selectors

These radio buttons appear in the Open dialog if the selected file is a stereo file. 

Only one channel (mono) at a time can be opened or Played from the dialog. The 
Channel selectors therefore allows you to select one of three alternatives:

• “Use Left Channel” and “Use Right Channel” access the corresponding 
channels in a stereo file.

• “Mix Left+Right” allows you to mix the two channels in a stereo file into 
mono, when opening the file.

Play and Stop buttons

When you click the Play button, the selected channel in the selected file will be 
played back. If you wish to stop playback before the file ends, click Stop.

Auto Play

If this option is on (ticked), playback will start automatically as soon as a new file 
or channel is selected from the dialog. If a new file or channel is selected during 
playback, the previous selection will stop and playback of the new selection will 
start directly.

You will not be able to play a file under the following conditions:

• If the file is in a format ReCycle doesn’t support.
• If there isn’t enough memory (RAM) left to load the sample.
• If the sample is longer than 30 seconds.
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Filetype Selector

• When the top item on this menu is selected, the file list will show all files 
in the directory that are in any of the formats that ReCycle supports.

• When any of the other alternatives are selected, the files list only shows 
files in that format.

About The Different File Formats

ReCycle loads 16 bit files with any sample rate.

The table below shows the supported file formats.

Some of the file formats below may contain more than one channel, that is they 
may be stereo files. As described above, the Open dialog will then allow you to pick 
one channel or a Mix of both. 

In addition, the Macintosh version of ReCycle supports the following format:

Finally, ReCycle “supports” yet another file format: ReCycle Export files (PC ex-
tension “.REX”). This is the file format used when exporting ReCycle files for use 
in other programs, such as Cubase VST. However, ReCycle Export files cannot be 
opened by ReCycle itself. For more information, see page 83.

Using Drag and Drop

ReCycle supports standard Drag and Drop. Proceed as follows:

1. In the Finder/Explorer, locate an audio file in one of the supported file 
formats.

2. Drag this file and drop it on the ReCycle icon.
If the program is already running, the file appears in a new window. If it isn’t, 
ReCycle launches and the file opens.

● If it’s a stereo file, a dialog will appear, asking you which channel to use. The 
options are the same as in the Open dialog.

Name Extension (PC) Comment

ReCycle RCY The files created when you save in ReCycle. 

Wave WAV The standard Microsoft file format for audio. May 
contain more than one channel and may be in for-
mats other than 16-bits.

Audio IFF 
(AIFF)

AIF Audio Interchange File Format; Apple’s standard au-
dio file format. May contain more than one channel 
and may be in formats other than 16-bits.

Name Full Name Comment

SD II Sound Designer II The current Digidesign file format. At least 16 
bits. May contain more than one channel.

Win:

Mac:
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Launching from Files

“RCY” files will open in ReCycle if you double click on them. In addition, you can 
open “WAV” or “AIF” files in ReCycle by right-clicking on them in the Explorer, 
and selecting “Edit with ReCycle!” from the pop-up menu that appears. If you 
chose to associate “WAV” or “AIF” file formats with ReCycle during the installa-
tion, you can open these files in ReCycle by double clicking, just as with “RCY” 
files.

On the Macintosh, any file created by ReCycle (except REX files) will open in Re-
Cycle if you double click it.

● If you open a stereo file this way, a dialog will appear, asking you which 
channel to use. The options are the same as in the Open dialog.

Receiving Audio from the Sampler

If you have an external sampler connected to the computer, ReCycle can receive the 
audio directly from it.

1. Make sure the sampler is selected on the lower half of the ReCycle Sam-
pler menu.
If the sampler cannot be found on the Sampler menu, you need to go into the 
Sampler Settings dialog and add the sampler, as described on page 38.

2. Select “Receive...” from the Sampler menu.
A dialog appears. Its exact appearance depends on which sampler you have.

The Yamaha A3000 Receive dialog.

3. In the dialog box you will find a pop-up which allows you to select a 
sample in the sampler.

4. Clicking Receive transfers the sample into the computer and opens it in a 
new window.
If you have selected a stereo sample, you will be asked which channel to use, 
just as when opening audio files from disk.

Win:

Mac:
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If the “Do you want to move the left locator...” dialog appears

If you Open or Receive a sample, and there is no loop setting, or the loop start is 
just at the beginning of the sample, a dialog appears suggesting you should let the 
program move the Left Locator to the first slice point. This is to avoid very short 
slices at the beginning of the sample. We recommend that you click “Yes” unless 
you have good reason. 

• If you want this to be done automatically, open the Preferences dialog on 
the Edit menu and activate the option “Always Move Left Locator to First 
Slice Point”.
When this is activated, ReCycle will automatically place the Left Locator on 
the first slice point when you Open or Receive a sample, without asking.

See page 68 for more information on setting Locators.
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Window Overview

Window Title

The window title displays three things:

• The name of the file.
• The sample rate at which the file was recorded (see page 77 for details about 

sample rates).
• An asterisk that indicates if the file hasn’t been saved yet.

Handling Windows
You can Open or Receive as many loops as RAM permits, and they will each ap-
pear in a window.

• For more information about window handling, see the documentation that 
came with your computer.

• ReCycle’s Windows menu contains a list of the currently open windows. Se-
lecting one makes that window active.

• The Close item on the File menu closes the active window.

 
Stop

Slice Audition buttons

Play Sensitivity sliderStretch slider

Transmit options buttons

Transmit/Export button

Tempo settings

Left Locator

Magnification Control

Tools Slice Marker

Waveform Length settings

Overview display

Right Locator
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Toolbox

The Toolbox is located in the upper left corner of the window. You select a tool 
from the Toolbox by clicking on its icon. Below follows a brief description of what 
the tools do. Detailed applications follow later in this chapter and in the following 
chapters.

Magnification, Song Position and Scrolling

The Magnification Indicator

If you click or drag in the magnification indicator, the amount of zoom changes. 
Furthermore, the indicator will always show the current magnification.

Using The Magnifying Glass

Zooming in

1. Hold down [Command] (Mac) / [Control] (Windows).

2. Move the mouse over the waveform area.
The pointer turns into a magnifying glass.

• Click once in the waveform.
The view is zoomed in one step. The position you clicked at will be centred 
in the window.

Zooming out

• Zooming out is done the same way as zooming in, except you also hold 
down the [Option] (Mac) / [Alt] (Windows) key.

The Zoom in and Zoom out pointers.

Tool Function

Arrow Used for selecting Slice markers.

Hide Used for deactivating slices by clicking on their markers.

Lock Used for locking slices, by clicking on their markers.

Pencil This is used for adding slices manually.

Arrow tool Lock tool

Pencil toolHide tool
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Using a Zoom rectangle

To select a certain area to zoom in on, proceed as follows:

1. Hold down [Command] (Mac) / [Control] (Windows) and press and hold 
the mouse button in the waveform display.

2. Drag to make up a selection rectangle.

3. Release the mouse button.
The selected area will now fill the entire window.

Zooming in on a certain area.

Magnifying using the Thumbnail Overview

• The method of making up a rectangle with the [Command] key (Mac) / 
[Control] key (Windows), described above, can also be used in the 
thumbnail overview.
This changes the zoom factor of the main waveform, not of the thumbnail it-
self.

Zooming in using the thumbnail.

Magnify to Fit/Magnify to fit Loop

If you select Magnify to Fit from the Edit menu, the display will zoom out so that 
the entire sample fits the window. If Magnify to Fit Loop is selected, the display 
will zoom in (or out) so that the area between the left and right locators will fit the 
window.
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Position

When you play back, the current position is indicated by a dotted line travelling 
across the waveform. If the option "Scroll during Playback" is checked in the Pref-
erences dialog, the current position will always be displayed in the waveform dis-
play. This option can also be toggled on or off by pressing [F] on your computer 
keyboard. A rectangle in the thumbnail overview indicates which area of the wave-
form is currently displayed in the waveform display.

The thumbnail overview shows you which part of the waveform is displayed.

The Scroll Bar

The scroll bar can be used to scroll the view of the waveform.

Scrolling using the Thumbnail

When zoomed in on the waveform, the Thumbnail Overview will display a rectan-
gle indicating which part of the waveform is now shown in the main waveform dis-
play. This rectangle can be dragged sideways, which scrolls the waveform display. 
You can also click anywhere in the Thumbnail Overview to move the rectangle to 
that position.

Dragging the Thumbnail rectangle.
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Waveform Display Options
You can customize the look of the Waveform window by using the three settings at 
the bottom of the Preferences dialog:

Waveform Color

Click this button to select a new color for the waveform. On the Macintosh, this 
brings up the standard Apple Color Picker, under Windows this brings up the stand-
ard Windows Color dialog. The color field to the right shows you the current color 
selection.

Waveform Look

Use this pop-up menu to select one of three different waveform "looks"; Plain, 3D 
or Shaded. Plain displays the waveform with normal graphics, 3D adds a depth ef-
fect to the graphics and Shaded adds a progressive shade to the lower part of the 
waveform.

Contrast Slider

This slider sets the amount of contrast between the background display and the 
waveform. For maximum contrast, position the slider all the way to the right. Mov-
ing the slider to the left progressively adds more of the chosen waveform color to 
the backround display.

The Edit menu
• The standard Edit menu items, Undo, Cut, Copy, Paste and Clear are not used 

by ReCycle and are therefore not available on the Edit menu.
• Select All and Invert Selection are explained on page 67.
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Audio Quality
ReCycle plays back audio directly from your computer, using the sound capabili-
ties of your specific computer (see the Installation chapters for more details).

● Please note that the quality of the sound during direct playback from the com-
puter may not be immaculate, depending on what hardware you are using. 
However, this does not reflect the final audio in the sampler, since this always 
maintains highest possible quality.

Playing the entire Loop
To play the entire loop, press [Enter] on the numeric keypad or click the Play but-
ton.

The Play Button

To stop playback, press [0] on the numeric keypad or click the Stop button.

The Stop Button

In addition, you can toggle between Play and Stop modes by pressing [Space].
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Auditioning Slices
There are three methods you can use to audition Slices:

• Using the mouse
When you move the mouse over the waveform area, the pointer turns into a 
speaker icon. When you click with the speaker tool on a Slice (a section of 
waveform between two Slice markers), it plays back. The “hot-spot” (the part 
of the pointer that you aim with) is indicated by a cross. Press [Space] to stop 
(even if you don’t, playback automatically stops at the end of the Slice).

• Using the Slice Audition buttons
The three Slice audition buttons are located to the right beside the Play and 
Stop buttons. They have the following respective functionality: 

The current Slice is indicated in the ReCycle window by a dotted vertical 
Slice marker.

• Using the numeric keypad
The keys [7], [8] and [9] on the numeric keypad has the same functionality as 
the corresponding three Slice audition buttons. Pressing [7] plays the previous 
Slice, pressing [8] plays the current Slice and pressing [9] plays the (current) 
Slice and moves to the next.

Play previous Slice (and make it the current). By re-
peatedly clicking this button, you can step through 
the Slices in reverse order and audition each one.

Play current Slice.

Play Slice and move to next (making the next Slice 
the current). By repeatedly clicking this button, 
you can step through the Slices from left to right 
and audition each one.

The “hot-spot”.

The current Slice
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Moving the Current Slice without Auditioning

You can also use the numeric keypad to move the current Slice without auditioning:

• Press [4] to move the current Slice to the previous Slice.

• Press [6] to move the current Slice to the next Slice.

• Press [1] or [2] to move the current Slice to the Left/Right Locator re-
spectively.
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Using Sensitivity
Most of the time when working with ReCycle, you will want to cut your loop up 
into slices. A slice is a section of the waveform, from one slice marker to the next.

When you load or receive a loop, ReCycle analyzes it to determine where slice 
markers should appear (where the individual sounds in the loop are).

The Sensitivity slider is then used by you, to set the overall amount of slices. The 
higher the sensitivity, the more slices you will get. And, the more slices you have, 
the smaller entities ReCycle will cut the loop into, when you transmit it. For more 
information, see page 66.

The number to the right of the slider represents the current position of the slider, 
where 0 represents minimum sensitivity and 99 maximum sensitivity.

As described below, the quickest way to get a good selection of slices is to set the 
sensitivity quite high, roughly between 70 - 80, and then use the Hide Tool to deac-
tivate any slices you don’t need (see later in this chapter for details on the Hide 
Tool).

Setting Sensitivity using the Keyboard

• You can type a number on the typewriter part of the keyboard, directly.
This can be used to quickly give the slider a rough setting. If you hit “1” it gets 
set to “11", if you press “2” it gets set to “22” etc.

• You can use the [+] and [–] keys to “nudge” the slider up and down.

A slice

A slice marker
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Using the Hide tool
You might run into situations where there are too many slices on the screen. You 
could of course reduce the Sensitivity to get rid of the slice markers you don’t want, 
but then other slice markers could disappear too, and this might not be desira-
ble.What you need to do in a situation like this is to “Hide” an individual slice, and 
this is just what the Hide Tool lets you do: When you select the Hide Tool and click 
on a slice marker it gets diminished and its line disappears.

Before and after Hiding a slice marker.

To try the effect of hiding, proceed as follows:

1. Click on two adjacent slices which play one sound each.

2. Hide the marker that divides the two slices.

3. Click again to audition.
You will hear that what was previously two slices is now one.

Bringing back Hidden Slices

To “re-activate” a hidden Slice, simply click on it again with the Hide tool.
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Hiding several Slices at the same Time

If you have several slices selected (see below) they will all get hidden when you 
click on one of them.

Clicking on one of the selected slices... ... hides all of them.

When do I use the Hide tool?

Use the Hide tool when you have a situation like the one below:

In the example above, the Sensitivity slider had to be set to a fairly high value get 
the number of slices you see. But raising Sensitivity led to one unwanted slice, 
splitting a sound in two. Hiding is the solution.

After Hiding the unwanted slice.

How do I find unwanted Slices?

Our most important tip is this: Always audition each slice to hear what they actually 
play. Try stepping through the loop with the “Play Slice and Move to Next” button, 
and adjust the Slices until you hear them the way you want them.

Another good practice is to increase magnification slightly and scroll through the 
slices to look for sounds that have been split unnecessarily. 

For optimal results, combine the two techniques above.

This slice is probably 
not wanted.
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Using the Lock Tool
The Lock tool is essentially the opposite of the Hide tool. If you lock a slice, by 
clicking on its marker with the Lock tool, it will stay even if you drag the Sensitiv-
ity slider all the way to zero.

If a slice is locked... ...it will stay even if you set Sensitivity to zero.

Locking several Slices at the same time

If you have several slices selected (see below) they will all get locked when you 
click on one of them.

Unlocking Slices

To unlock a locked Slice, simply click on it again with the Lock tool.

When do I use the Lock tool?

If you got a good set of slices by just using the Sensitivity slider, but discover that 
in one or two places you hear two sounds when you click on a slice, then it is time 
to bring out the Lock tool.

1. Find the place where you hear two sounds when auditioning.

2. Make a mental note of the current slider setting.

3. Set the sensitivity slider to a higher value to get a slice between the two 
sounds.

4. Audition to make sure you got what you wanted.

5. Lock the new slice.

6. Drag the sensitivity slider to the original setting.

Clicking on one of the selected slices... ...locks all of them.
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Adding Slices manually

● Before adding slices manually, make absolutely sure the slices found by the 
analyze algorithm don’t suffice. The program is very good at finding slice 
points, and the points found by the program often work better – for example 
for tempo changes – than the ones that you can add manually.

1. Identify the area where you need a slice, and zoom in very close on it.

2. Select the Pencil Tool.

3. Move the pointer over the waveform display.
A vertical line moves across the waveform. This line indicates where the slice 
will appear when you click. The line snaps to zero crossings in the waveform 
(positions where the amplitude is zero), so manually added slices won’t intro-
duce any clicks or pops. If the amplitude is zero for a period of time, the line 
will move continuously over this area.

The vertical line snaps to zero crossings.

4. When you have found the correct position, click with the Pencil.
The slice appears.

The following rules apply to manually added slices:

• To “remove” an added slice, Hide it as any other.
• Manually added slices are locked. They will therefore not disappear when 

you lower Sensitivity.
• If you unlock a manually added slice and drag the sensitivity slider down 

lower than halfway (below 50), it will disappear, just as other slices.

Adding a Slice at any position

• If you hold down [Option] (Mac) / [Alt] (Windows), the snap to zero 
crossing is disabled and you can add a slice at any position.
We do not recommend that you do this unless you have very good reason, 
since it can introduce clicks and pops in the sound during playback.
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When do I add Slices manually?

As described above, we suggest you only add slices manually when the program 
fails to find one at a position where you need it. In other words, you will need to 
add a slice manually when you click on a slice and hear two sounds, one after the 
other, even though the Sensitivity slider is set to 99.

Where do I add the Slice?

Zoom in far enough for the display to clearly show how the cursor jumps between 
zero crossings. Try to find the first position before the beginning of the sound. If 
you make a mistake, simply hide the slice you created and add a new one at another 
position.

How many Slices do I need?
Well, it depends...

• If you have Transmit As One Sample (on the Sampler menu) turned on, you 
don’t need any slices at all, except when you move the Locators to find a 
good loop point.

• If you plan to edit the loop a lot in your MIDI sequencer, you should try to get 
one slice per sound in the loop, or in some situations (very busy sections for 
example), one slice per eighth note or sixteenth note (to simplify editing in the 
sequencer).

• If you want to create a groove, you should try to get approximately one slice 
per eighth note, sixteenth note or whatever the loop requires.

• If your main reason for slicing the loop is to change the tempo, you generally 
need as many slices as you can get, but never more than one per individual 
sound in the loop. This is to retain the “integrity” of each sound when played 
back from the sequencer.

● Please remember that your ears are always the best judge. Careful auditioning 
is vital for finding a good selection of slices. Since transmitting to the sampler 
and trying the loop out in the sequencer is so quick and easy, do not hesitate 
to go back, change the slicing and re-transmit.
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Selecting Slice Markers
Slice markers need to be selected for some operations, like Silence Selected (see 
page 73 and page 91):

• Selecting is only done with the Arrow Tool.

• You can select one marker by clicking on its triangle symbol.

• If you hold down [Shift], you can click on more markers to select them. 
Clicking again with [Shift] pressed deselects a marker.

Selected and unselected markers

• You can make up a selection rectangle by pointing between slices, press-
ing the mouse button and dragging left or right. When you release the 
mouse button, all the slices inside the rectangle will get selected.

• You can use the Select All item on the Edit menu to select all markers.

• If you have a selection of markers, you can invert the selection by using 
“Invert Selection”, also on the Edit menu. 
After this operation, the markers that were previously selected are now dese-
lected, and vice versa. This is mainly useful together with Silence Selected, 
see page 73 and page 91.

Before and after using “Invert Selection”

• To deselect all markers, click between two markers on the ruler.

Making up a rectangle like this... ...selects these markers.
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Left and Right Locator — Setting the Loop

By dragging

The left and right Locators can be dragged to set the Loop during playback.

• If you have no slices at all (if the Sensitivity slider is all the way to the 
left), the Locators can be positioned freely.

• If there are any slices visible, the Locators snap to the lines.

• If you want to position the Locators freely, even though you have slices, 
hold down [Option] (Mac) / [Alt] (Win) while dragging a Locator.

By clicking

• To set the Left Locator, hold down [Shift] and click on the ruler.

• To set the Right Locator, instead hold down [Command] (Mac) / [Control] 
(Win) and click.

• Normally, the positions snap to the closest slice point, but if you also 
hold down [Option] (Mac) / [Alt] (Win) when you click, you can set the 
Locator at any point.

Use the Slices when setting Loop Points!

When trying to find a good loop point, use snap to slices if at all possible. If you 
can’t seem to get a good loop point that way, try raising the Sensitivity slider to get 
more slices and try again.

When – and only when – you can’t find a good loop point in this way, zoom in and 
adjust the Loop positions with [Option] (Mac) / [Alt] (Win) pressed.

What are the Locators used for?

The Locators are of course used to define the loop you get during playback. But 
they also have other purposes:

• ReCycle uses the Locator positions when calculating the tempo of the Loop.
• When transmitting audio to the sampler, only the part between the Locators is 

actually sent.
• When you create MIDI files, only the section between the Locators is taken 

into consideration, as with the transmitted audio above.
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Tempo, Time Signature, Bars and Beats
Many of the operations in ReCycle require you to specify how long the loop be-
tween the Locators actually is, meter-wise. This information is then used to calcu-
late the tempo of the loop.

Time Signature

The Sign pop-up menu allows you to choose between a few of the more common 
Time Signatures. If none of them fit your purpose, you can still “assemble” a cor-
rect Time Signature using the Bars and Beats settings, see below.

Bars and Beats

The Bars field and Beats pop-up are used to specify the length of the loop. Lets ex-
plain this by example:

As stated above, you can use Bars and Beats to “create” some unusual Time Signa-
tures:

Tempo

When the Left and Right Locators are set, and the correct Time Signature and loop 
Length (Bars and Beats) are specified, this field will show the tempo of the loop. 
This tempo is inserted into the MIDI Files that ReCycle creates, if “Pitch to New 
Tempo" on the Sampler menu is turned off. See below and page 89.

New Tempo

This field is only available if the “Pitch to New Tempo” option is activated. It is 
used when you want to match a loop to another tempo by tuning it in the sampler, 
rather than by Slicing it. See page 74 and page 93.

Actual Loop Length Set “Bars” to: Set “Beats” to:

One bar 1 0

Two bars 2 0

Half a bar in 4/4 0 2

One and a half bar in 6/8 1 3

Actual Loop Length Time Signature  Bars Beats

One bar in 5/4 4/4 1 1

Two bars in 7/4 4/4 3 2

One bar in 9/8 6/8 1 3
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Selecting a Sampler to Transmit to
To route the Receive and Transmit functions to a particular sampler, select it from 
lower section of the Sampler menu. If your sampler is not on the menu you must 
add it in the Sampler Settings dialog, see page 38.

An Akai S3000 selected.

You can have several samplers connected, either of different types or of the same 
type, but only one at a time can be selected.

You can switch samplers while you are working with the program, which allows 
you for example to Receive a sound from one sampler and Transmit it to another.

Transmit/Export and Memory
The program needs free memory in the computer for Exporting and Transmitting. 
In a worst case (with Stretch set to 100%) it needs twice the memory of the longest 
slice. This means that if you have “Transmit As One Sample” turned on and use 
high Stretch factors, you need to make sure you have enough memory left, when 
you Transmit.

For more information, see page 17 and page 45.
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Transmit Options

The Sampler menu contains a number of Transmit settings (or “options”), some of 
which can be turned on/off and others which can be set to a certain value. These 
four options can also be turned on or off using the four Transmit Options buttons:

Each document has its own settings. If you are working with a lot of windows, be 
sure to check that the settings are correct before you Transmit.

The settings only come into effect when the audio is actually being transmitted to 
the sampler, or when the MIDI File is being created. They have no effect on play-
back in ReCycle. But if you want to hear a preview of the effect they have, you can 
use the “Open Slices in New Window” option described below.

The settings are also saved to disk with the file when you Save.

You will find applications of all options below, and on page 86 and onwards.

Transmit as One Sample

Deactivated

When Transmit As One Sample is turned off, the audio gets sliced into individual 
samples when transmitted, and the MIDI files created will contain one note for each 
of those slices.

This is the preferred mode if you want to use your MIDI sequencer to edit the loop, 
change its tempo or use the MIDI file as a groove.

Activated

When Transmit As One Sample is turned on, the program will transmit the part that 
stretches from the Left Locator to the Right as one sample. Also, in this mode, the 
MIDI File will only consist of one event, with the length set using the Bars and 
Beats settings.

This mode is mainly useful if you simply want to use ReCycle to find the right 
tempo for a loop, when you want to use the Pitch to New Tempo feature to tune the 
sample to the right length or when you want to use ReCycle to extract sounds.

Normalize Silence Selected

Pitch to New 
Tempo

Transmit as 
One Sample
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Normalize

With Normalize turned on, ReCycle will permanently change the gain of each slice 
before transmitting it to ensure maximum level. This is to ensure the noise level is 
kept as low as possible during playback.

However, if you transmit a loop as a number of slices, normalizing will disrupt the 
dynamics of the drum loop, since the gain of each slice is changed separately. 
Therefore, normalizing is probably best used when you have Transmit As One 
Sample turned on (in this case the entire loop is treated as one long sample when 
being normalized) or when you use the program to extract individual sounds.

● Normalize can’t do miracles. If your recording contains unwanted noise, nor-
malizing will increase the noise level together with the other audio material.

Silence Selected

When this flag is turned on, the slices that have selected markers will be silenced in 
the final audio.

When Silence Selected is turned on, the slices which have selected markers...

...will be replaced by silence in the final audio.

This feature is probably best used when Transmit As One Sample is turned on, to 
silence individual sounds in a longer sample. An application of this is found on 
page 91. It can also be used to simply skip unwanted sounds, when slicing.

But, Silence Selected works even if Transmit As One Sample is turned off. In this 
case, the selected slices will simply be skipped, both when transmitting to the sam-
pler and when creating MIDI Files. This will then create “gaps” in the sampler's 
keyboard map and a corresponding “gap” in the MIDI File.
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Pitch to New Tempo 

This setting is used when you want to make a loop fit a certain time span by chang-
ing its tuning (pitch) rather than by slicing it.

In the dark ages, before ReCycle, the only way to make a loop fit a certain tempo 
was to either use a Time Stretch program such as Steinberg’s TimeBandit or 
WaveLab, or to change its tuning until it fitted an existing song. This feature lets 
you perform exactly that option, but in a more convenient way than by twiddling 
the knobs on your sampler.

Let’s say you have set up a loop and have had ReCycle calculate the tempo of it to 
be 100 BPM (beats per minute). Your Song is in 110 beats per minute. So you type 
in 110 as your New Tempo, turn on “Pitch to New Tempo ” and transmit the sample 
back to the sampler. 

When you do this, ReCycle will reach into your sampler and raise the tuning setting 
for this particular sample by “0.65” semitones, so that when you press a key, the 
loop will fit 110 BPM exactly (no, you don’t want to know about the mathematics 
behind this, trust us!).

More info on page 93.
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Stretch

This feature is used when you know you might want to lower the tempo of the loop 
in your MIDI sequencer.

How Stretch works

When you slice up a loop and play it back from your sequencer, each sample will 
play in succession. At the original tempo, one slice will end exactly where another 
starts.

As you understand, when you then lower the tempo, there will be small gaps be-
tween the slices, which disrupts the flow of the audio.

Stretch is used to add an extra tail of audio to each slice, to lengthen it. This tail is 
derived from the natural decay of the sound. This extra tail of sound then fills out 
the gap between the slices when the tempo is lowered.

● Please note that the attack of the sound is not affected in any way. 

The Amount of Stretch

The Stretch slider is used to set the amount of stretch.

The percentage values tell you how much longer the entire sample will be after 
stretching. If you select the largest value (100%), for example, the slice will be-
come twice its original length when transmitted to the sampler.

To decide how much stretch you need, try to make a rough estimate of how much 
you need to lower the tempo, in percent. If for example you know that you will 
need to lower the tempo by approximately 12%, select a stretch factor of 15%. If 
that doesn’t work as intended, change the Stretch setting and re-transmit the slices.

● Please note that just setting a Stretch factor does nothing. It is only when you 
transmit the slices that the audio actually gets stretched.

Stretch is not Time Stretch!

Again, the Stretch feature doesn't lengthen the whole slice, it only adds a portion of 
sound to the end of it. You can use the “Open Slices in New Windows” feature to 
roughly try out the effect of stretching, as it would turn out in the sampler. But do 
not expect as good results from this, as when you transmit the loop to the sampler.
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The Transmit dialog(s)
The top menu item on the Sampler menu changes name depending on which sam-
pler or option you have selected. For external samplers it is called “Transmit to...”. 
For internal samplers and other formats (see the online Sampler Supplements doc-
ument) for which the program saves audio files on your computer’s hard disk, the 
item is called “Export as...”, and if the New Window option (see page 87) is se-
lected the menu item is called “Open Slices in New Window”.

There are three ways you can execute Transmit:

• By clicking the Transmit button.

The Transmit button.

• By pressing [Command]+[T] (Mac) or [Cntrl]+[T] (Win).

• By selecting “Transmit to...” from the Sampler menu.

The Sampler menu when an A3000 is selected.

The Transmit dialog when a Yamaha A3000 is selected.

Exactly how the dialog looks depends on the selected Sampler, but there are a few 
standard items you will most often find there:
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Sample rate

ReCycle can handle samples with any sample rate and can convert samples from 
any rate to any other.

Title shows inherent rate

When you Open or Receive a sample, its inherent sample rate is displayed in the 
window title.

A sample recorded at 44.1 kHz.

Available rates

In the transmit dialog, a number of sample rates can be selected from a pop-up. Ex-
actly what options are available depends on the sampler selected.

• If possible, the sample’s inherent rate is suggested.
If, for example, the sample was recorded at 48 kHz, this will be the suggested 
sample rate in the Transmit dialog.

• If the sample’s inherent rate is not supported by the sampler, the next 
higher rate is suggested.

• In addition to the above, a number of other sample rates can be selected 
from the pop-up in the Transmit dialog.
If the sampler only handles a few sample rates, they can all be selected. If the 
sampler supports many rates, the most commonly used ones (or the ones clos-
est to these) are available. Those most common rates are 11.025kHz, 
22.05kHz, 32kHz, 44.1kHz and 48kHz.

When is sample rate conversion performed?

If you transmit, and the sample rate set in the Transmit dialog is not the same as in 
the window title (the sample’s inherent rate), a sample rate conversion will be per-
formed during the transmission.

When should I change from the suggested sample rate?

Lowering the sample rate will make the samples occupy less memory in the sam-
pler, but it will also lower the fidelity of the recording (less high frequency material 
will be present).

On the other hand, increasing the sample rate will not raise the fidelity of the sam-
ple in any way. It is therefore not recommended to convert from a low rate to a 
higher one, unless it is required by the sampler.
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Templates

When ReCycle sends audio to your sampler it will put the samples it creates in a 
“container” which holds all the samples and their mapping on the keyboard. This 
“container” may be called a Program, Instrument, Patch or similar, all dependent on 
the naming used by the sampler manufacturer. For now, let’s call it a Program.

There are a number of settings in the Program which may or may not be of impor-
tance to you. 

• If the settings are not important to you, you don’t need to use templates, you 
should use the Default option in the Transmit dialog. ReCycle will then simply 
create as simple a Program as possible. You can then change this Program’s 
settings by using the controls on the sampler itself.

• If you do need special settings, you use Templates. You might for example 
want the first slice to appear on a certain key, you might want to have all sam-
ples play to a certain output, you may want the Program to receive on a cer-
tain MIDI Channel etc. Proceed as follows:

1. On the sampler, manually create a Program with the desired settings.
Make sure the first sample in the Program’s keyboard map is positioned 
where you want the first sample in the keyboard map created by ReCycle.

2. Save this Program to disk (using the sampler’s regular file saving func-
tions), for later use, but make sure it still resides in the sampler’s internal 
memory.

3. In the ReCycle Transmit dialog, activate this Template.
Exactly how this is done depends on the sampler. If it is external you can se-
lect the Program from a pop-up menu in the dialog. If ReCycle saves the data 
on to your computer’s hard disk, then you select a disk file as your template.

4. Transmit/Export the Program.
A new Program is created in the sampler. It will get all the settings of the Tem-
plate. The first slice will appear on the same key as where the first sample in 
the Template was.

● If you use exactly the same name as the Template, the new Program will re-
place the Template.
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Name

Using this field you can specify a name for the Programs you are about to create in 
the sampler.

• If the sampler is external you will be able to specify the name directly in the 
dialog. You will only be able to type in characters supported by the sampler, 
and the name will be truncated to fit the length of the names in the specific 
sampler.

• If the sampler reads files from your computer’s hard disk, a regular file dialog 
will appear when you click one of the Export buttons (see below), allowing 
you to name the Program disk file.

• The actual slices that the Program contains will in both cases get names de-
rived from the Program name, with a number added at the end. For example 
BigDrums#01, BigDrums#02, etc.

Transmit/Export

This button creates a Program and samples for it as described above, without creat-
ing any MIDI File.

MIDI File + Transmit/Export

This button will make two things happen :

• Programs and samples are created as described above.

• A file dialog appears, which allows you to create a MIDI File on your 
computer’s disk.
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The New Window option
One of the “samplers” on the sampler menu is called “New Window”. When this is 
selected, the Transmit/Export item on the Sampler menu is called “Open Slices in 
New Windows”.

When you “Open Slices in New Windows”, you will get a preview of what would 
have been sent to the sampler. If Transmit As One Sample is turned off, each slice 
appears in its own window; if Silence Selected is turned on the selected slices will 
be silenced; if Stretch is set to anything but Off, each slice will be stretched etc 
(however, the Pitch to New Tempo option does not affect slices opened in new win-
dows).

The audio you get in the new window(s) is the same as you would have been get-
ting had you Opened or Received it. It can be used – as mentioned above – as a pre-
view of what you will be getting in the sampler, or as a basis for a new piece of 
audio to Transmit or Export to disk (see below).

Here are few examples of what “Open Slices in New Windows” can be used for:

• To extract a shorter part from a long sample.
• When you use Silence Selected, to check that you have selected the right 

slices.
• To see exactly how much Normalizing does to a sample.
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Saving ReCycle documents
If you have Opened an audio file and worked on the slices and other settings, you 
can save it as a ReCycle document. 

• Saving is done using regular “Save” and “Save As” methods.

• ReCycle files can be opened just like regular audio files (see page 45). 
The only difference is that no analysis needs to be performed, since the anal-
ysis data is already included in the file.

• On the PC, ReCycle files have the extension “.RCY”.

• The ReCycle documents include the following:
The audio data.
All the slice points and their status (locked, hidden etc).
All Transmit options on the Sampler menu.
The Stretch amount.
The Sensitivity and Length settings.

Saving a ReCycle file has a number of advantages:

• No analysis needs to be performed, which makes opening files in this format 
faster than other formats.

• In case you want to go back and adjust the slice points after transmitting, no 
work has to be redone if you have saved the file as a ReCycle document.
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Export Sound
This item on the File menu allows you to save all the audio between the Left and 
Right Locator to disk. These files can then be brought into any audio editing or 
playback program that supports any of ReCycle's possible export file formats.

The same logic applies as when Transmitting. This means for example that if 
Transmit As One Sample is turned off, each slice will become a separate file (see 
page 72 for more info).

File Type and Sample Rate

The Export Sound dialog contains two pop-up menus not found in the Save dialog.

• File type. See page 47 for details.
• Sample rate. See page 77 for more info.

The audio files created by ReCycle are always mono, 16 bit.

Exporting requires memory, see page 71.

Export to REX format (for Cubase VST)
The ReCycle Export (REX) file is a special file format which makes it possible to 
use ReCycled files in other programs, without the need of a sampler. ReCycle Ex-
port files have the following properties:

• The files contain both the actual audio, the Slice information and the tempo.
• On the PC, ReCycle Export files have the extension “.REX”.
• ReCycle Export files cannot be opened in ReCycle.

To ReCycle a file for use in Cubase VST or other programs capable of reading REX 
files, proceed as follows:

● This text describes how to use REX files with Cubase VST. If you are using an-
other REX-compatible program, see its documentation for details.

1. Locate the file on disk and open it in ReCycle.
This can be a file recorded in Cubase, or a file of any other origin.

2. Set up the slices, length, time signature and sampler options as desired.
A typical application would be “slicing for tempo changes”, see page 89.

3. Select “Export to ReCycle! REX file”, from the File menu.

4. Select a sample rate for the exported file.
Make sure to select a sample rate that is supported by the destination pro-
gram.

5. Specify a location and name for the file and save it.

6. Switch over to Cubase VST.
You need version 3.02 or later on Mac, or version 3.55 or later on PC.
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7. Select an Audio Track where you want to import the file and set the Left 
Locator at the position where you want the file to appear.
Depending on the type and complexity of the audio, you may want to set the 
Audio Track to channel “Any”. See the Cubase VST documentation for de-
tails.

8. Select “Import ReCycle file”, from the File menu.

9. Locate the ReCycle export file you just saved, and open it.
Now the following happens:

• The file is added to the Pool.
• A number of Segments are created for the file, each one corresponding to a 

slice in Recycle.
• A Part which will play these Segments is automatically created on the active 

Track, starting at the Left Locator position.
Now you can play back the ReCycled file in any tempo, as if using a sampler. 
You can also edit it in detail, quantize, etc.

• If you need to re-import the file into the Arrangement, drag the file item 
from the Pool to the Arrangement, just as any other file. 
A new Part is then created.

● There are a number of additional factors to be aware of when using REX files 
in VST. See the VST manual for details!
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Exporting MIDI Files
There are two ways to create MIDI Files with ReCycle:

• By selecting “Export Groove MIDI File” from the File menu.
• By clicking the MIDI File+Transmit/Export button in the Transmit/Export dia-

log (see page 79).

The MIDI Files created are identical in both cases. So why use one or the other? 
Well, normally you will create MIDI Files as a part of the Transmission process (by 
clicking “MIDI File+Transmit/Export” in the Transmit dialog). But if you only 
want to create a MIDI File (for example when using ReCycle to create “groove 
maps”), use Export Groove MIDI File.

In either case you are prompted with a regular File dialog where you can specify a 
name and location for the file.

ReCycle always creates MIDI Files of type 1. However, they only contain one 
Track plus a Tempo Track.

Templates and MIDI Files

• If you create a MIDI File from the Transmit dialog, the position of the first sam-
ple in the Template affects the transposition of the MIDI File (so that the file 
plays the right samples).

• If you use “Export Groove MIDI File” the first note is always C1.

“Transmit As One Sample” and MIDI Files

• If Transmit As One Sample is turned off, the MIDI File will contain a number 
of short events, each triggering a slice in the sampler, to recreate the loop. 
This is the mode to use if you want to create a “groove map”.

• If Transmit As One Sample is turned on, there will only be one long event 
which triggers the entire sample.

“Pitch to New Tempo” and MIDI Files

• If Pitch to New Tempo is turned off, the MIDI File will get the tempo calcu-
lated by ReCycle (displayed in the “Tempo” field in the ReCycle window).

• If Pitch to New Tempo is turned on, the MIDI File will have the Tempo set in 
the “New Tempo” field in the ReCycle window.

“Silence Selected” and MIDI Files

Silence Selected only affects the MIDI File if Transmit As One Sample is turned 
off, as described on page 73. In this case, there will be “missing” events in the File, 
namely those which were set to be silenced (the selected ones).

“Stretch” and MIDI Files

The Stretch setting has no effect on the MIDI Files created by ReCycle.
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Which Samples will work?
All. But although ReCycle does a very intelligent analysis of the sample to find the 
individual “hits” or “sounds” in it, the sample has to meet some basic criteria to en-
able the automatic algorithm to find all the individual sounds:

• Each sound in the sample must have some kind of perceivable attack. You 
will for example run into problems with legato playing on a flute.

• The sample must be adequately recorded. Weak sounds recorded at very low 
volumes might not get all the slices they should.

• The program might have problems with sounds drowned in smearing effects, 
like extremely thick chorus or short repeating delays.

Please remember that you always have the possibility to add slices “manually”.

Using Normalize to increase “readability”

If you have a loop that was very poorly recorded, you might be able to get a better 
recognition by normalizing it before trying to find slices:

1. Set Sensitivity to 0.

2. Drag the loop points all the way to the left and right, respectively.

3. Set Bars to any value but 0.

4. Set up the Transmit options as follows:

5. Select “New Window” as Sampler and then select “Open Slices in New 
Window”.
You will now have a normalized copy of the original file. Raise Sensitivity to 
check if the recognition got better.

Transmit As One Sample On

Normalize On

Silence Selected Off

Stretch Off

Pitch To New Tempo Doesn’t matter
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The Simple Trim
The most basic thing you can do with ReCycle is to set a good loop point for a sam-
ple and then retransmit it to the Sampler, without any slicing or processing.

1. Open or Receive the sample.

2. Raise the Sensitivity until a large number of slices appear.

3. Activate playback and move the loop points until you find a good loop.

4. Make sure the loops starts on a downbeat (sometimes you might decide 
to let the loop start somewhere else but we just want to make sure this 
doesn’t happen by accident).

5. Set the Time Signature and length (Bars/Beats) to whatever the length of 
the loop.
The Tempo gets calculated.

6. Set up the Sampler Options like this:

7. Select your sampler from the Sampler menu and select Transmit/Export 
or MIDI File+Transmit/Export.
The MIDI File you get will contain one event which plays the entire loop at 
the calculated tempo.

8. Load the MIDI File into your sequencer and set things up so that it plays 
the correct “Program” in your sampler.

9. Repeat the MIDI File in your sequencer, as needed.

Transmit As One Sample On

Normalize Off

Silence Selected Off

Stretch Off

Pitch to New Tempo Off
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Slicing for Tempo Changes
1. Open or Receive the sample.

2. Raise the Sensitivity Slider until a lot of slices appear.

3. Activate playback and move the loop points until you find a good loop.

4. Work on the slices with the Hide and Lock tools until you have one slice 
per sound in the loop.
It is important that no slice plays two consecutive sounds, so audition them 
one at a time to check. 

5. Set the Time Signature and length (Bars/Beats) to whatever the length of 
the loop.
The Tempo is calculated.

6. Set up the Sampler Options like this:

7. Select your sampler from the Sampler menu and select MIDI File+Trans-
mit/Export.
The slices are transmitted. The MIDI File you get will contain a number of 
notes which play back the Loop (the slices in the sampler) in its original 
shape.

8. Set things up so that the sequencer plays the new “Program” in your 
sampler.

9. Load the MIDI File into your sequencer and play it back. Try varying the 
tempo.

10.Repeat the MIDI File in your sequencer, as needed.

Transmit As One Sample Off

Normalize Off

Silence Selected Off

Stretch If you plan to lower the tempo, set this as suggested on 
page 75.

Pitch to New Tempo Off
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Slicing for Editing
If your main goal is to edit the loop, rather than changing its tempo, you may take a 
slightly different approach compared with slicing for tempo changes:

1. Set things up as in the example above.

2. Work on the slices with the Hide and Lock tools until you have approxi-
mately one slice per eighth note, sixteenth note or whatever you need, 
depending on how detailed an edit you want to do.
If a slice plays more than one sound, please remember that you won’t be able 
to edit these two sounds independently. There are occasions when this will be 
perfectly OK though, for example when you just want to shift the order of the 
beats around in the loop.

3. Proceed as from point 5 in the previous example.

4. In the MIDI Sequencer, open the MIDI File for editing. When you move 
slices around, make sure they keep their relative position to the beats, 
eighth notes etc, to maintain the integrity of the timing in the groove.
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Using Silence Selected
Even if you don’t want to cut up a loop in slices, you can still use ReCycle to send 
different sounds in the loop to different outputs. The example below assumes you 
only want to pick out one sound, but the same technique can of course be applied to 
separate as many sounds as you need.

1. Open or Receive the sample.

2. Raise the Sensitivity until a lot of slices appear.

3. Activate playback and move the loop points until you find a good loop.

4. Set the Time Signature and length (Bars/Beats) to whatever the length of 
the loop.
The Tempo gets calculated.

5. Set up the Sampler Options like this:

6. Work on the slices until they play one sound each when you click them.

7. Select all slice markers which play the same sound, for example the snare 
drum.

8. If you wish to, select New Window as your “sampler” and transmit the 
loop to a new window. Play it back to check that all snares are silent.

9. Select your actual Sampler from the sampler menu and select Transmit/
Export or MIDI File+Transmit/Export.
The MIDI File you get will contain one event which plays the entire loop at 
the calculated tempo.

10.With the selection still set up as before, select “Invert Selection” from 
the Edit menu.
Now all sounds that are not snares are selected.

11.Transmit the sample again to the sampler, but under another name.

12.Set up the sampler and sequencer so that the two samples are played 
back at the same time. Also set up the sounds to one output each. They 
will together recreate the loop as it was, but the snare will be separated 
to its own output, which means that you have independent control over 
its volume, that you can EQ it separately, that you can add effects to the 
snare only, etc.

Transmit As One Sample On

Normalize Off

Silence Selected On

Stretch Off

Pitch to New Tempo As you like
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Extracting a Groove
If you think about it, you will realise that all ReCycle MIDI Files are actually tim-
ing maps of how the drums were played in the loop. Many sequencer programs 
have the ability to load MIDI Files and apply their timing to the sequenced parts. 
The terminology used is “Match Quantize” or “Groove”. 

If you use a ReCycle MIDI File as a “groove template”, you can make your se-
quenced parts play back with the timing of the drum loop. For this, you could of 
course use the MIDI File you get when Transmitting slices to the sampler. But, you 
can also create a timing file only, using “Save Groove MIDI File”. Proceed as fol-
lows:

1. Open or Receive the sample.

2. Raise the Sensitivity Slider until a lot of slices appear.

3. Work on the slices with the Hide and Lock tools until you have one slice 
per eighth note or sixteenth note.
In many situations there will be no sound on a certain eighth or sixteenth 
note. There’s not much you can do about this. You can copy another MIDI 
note in the sequencer later, or insert a new one “by hand”. You can also add 
a slice manually, at any position.

4. Set the Time Signature and length (Bars/Beats) to whatever the length of 
the loop.
The Tempo gets calculated.

5. Set up the Sampler Options like this:

6. Select Save Groove MIDI File from the File menu and save the MIDI File.

7. If you use Steinberg Cubase VST, applying the MIDI File to existing music 
is a piece of cake. Just Import the MIDI File into an Arrangement and use 
Match Quantize to drag the groove onto a MIDI recording.

Transmit As One Sample Off

Normalize Doesn’t matter

Silence Selected Off

Stretch Doesn’t matter

 Pitch To New Tempo Doesn’t matter
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Quantizing Audio
If you have sliced a groove or other recording, you can apply quantizing to it in the 
sequencer, if you like.

● When Transmitting, use at least a small amount of Stretch, to avoid the gaps 
between slices that might otherwise occur.

Please note that if you have two sliced loops in a Cubase Arrangement, applying the 
timing of one of them to the other is really easy. Just use the Match Quantize tool to 
drag one of the Parts on top of the other (see the Cubase manual for details).

If you don’t like what you get, Undo the Quantize, and try the other way around, for 
example.

Using New Tempo
If you have a Song which plays in a different Tempo from that of the loop, you can 
of course slice the loop in order to change its tempo without altering the pitch. This 
is described under the earlier heading “Slicing for Tempo Changes”. However, if 
you’d rather not slice the loop but instead use the tuning setting in your sampler to 
make the loop fit a certain tempo, proceed as follows:

Set everything up as in the previous example, but before selecting Transmit/Export, 
perform the following steps:

1. Turn on “Pitch to New Tempo” on the Sampler menu.

2. Click in the “New Tempo” field in the ReCycle window, type in the de-
sired Tempo and press [Return].

3. Transmit to sampler and create a MIDI File.
The sample will be tuned to match the tempo.
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Extracting Sounds
This can be used to extract single sounds (snares, hi-hats etc) from a loop or other 
recording). It can also be very useful if you have recorded more than one drum loop 
into a file and want to save each one as a separate file. 

1. Open or Receive the sample.

2. Raise the Sensitivity Slider until the desired number of slices appears.

3. Work on the slices with the Hide and Lock tools until you get the sounds 
you want when you audition.
In the case of the “multi-loop” file outlined above, this would mean one slice 
per loop.

4. Set the Loop point to enclose the first and last sound you want from the 
loop.
This might mean unwanted sounds are transmitted, but these can always be 
deleted in the sampler. Or you can use “Silence Selected” to prevent some 
slices from being sent.

5. Set “Bars” to any value but zero.

6. Set up the Sampler Options like this:

7. Select your Sampler from the Sampler menu and select Transmit/Export.
The slices get transmitted. Alternatively, you can use Export Sound to save 
each slice as a file.

Transmit As One Sample Off

Normalize On

Silence Selected Off or On (see point 4 above)

Stretch Probably Off, but you could use Stretch to lengthen 
the sounds and give them a more natural decay.

Pitch to New Tempo Off
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Using Loops with unusual length or cutting
Sometimes you don’t have a full bar of a loop. Set up the loop and the Bars and 
Beats fields for as much as you have. Then slice the loop. Finally, use your se-
quencer’s editing capabilities, on the MIDI notes, to recreate the missing parts.

You will also encounter situations where the best loop doesn’t really start on a 
downbeat. It might for example happen that you get the best loop when you posi-
tion the Left and Right Locator on the last quarter note of two consecutive meas-
ures.

If this happens, you can fix it in Cubase, by cutting the last quarter note of the MIDI 
Part and pasting it in at the beginning, to position the downbeat correctly. If you 
don’t want to slice the loop completely, at least allow a slice at the downbeat (the 
Lock tool is ideal for this). Then, repositioning that last quarter note to the begin-
ning of the loop will be very easy. 
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